
MANUAL FOR WORKING WITH MODIS IMAGES
IN SEADAS 6.2
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By : Vera De Cauwer, Polytechnic of Namibia

This  manual  was written for the students of the School of Natural  Resources and Tourism, 
Polytechnic of Namibia during the pilot  project “Assessing potential  to produce final Ocean 
Colour  maps  of  Namibia’s  marine  environment”,  which  is  supported  by  the  BCLME 
Programme and the Polytechnic of Namibia.

The manual is written for students working with the SeaDAS software on the Linux computer of 
the Department of Land Management (operating system is Fedora Core 10) or the version of 
SeaDAS which  can  be  installed  in  Windows  through  a  virtual  application  Vmware  player 
(seadasva).  The images used are MODIS Aqua provided by NASA (HDF version 4 format).  
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A. Downloading MODIS images

Select and download Level 1 and 2 images from the Ocean Color website : 
http://oceancolor.gsfc.nasa.gov/cgi/browse.pl?sen=am

(or go the OceanColor website at http://oceancolor.gsfc.nasa.gov/ and click on the Level 
1 and 2 Browser).

You will  be able  to  enter  the parameters  of the image(s)  you  are searching for.   Enter  the 
following details :

Sensors: MODIS(Aqua) and MODIS (Terra)
Select one or more regions: NamibiaCoast (or: region bounded by N: -17.0S, S: -28.0S, 
W: 10.0 and E:16.0)
Mission: indicate period desired (if you want the entire mission, do not indicate any 
period)

Click on Find Swaths
Have a better look at the most cloud free images by clicking on the thumbnails.

If an image is of satisfactory quality (a significant area of the Namibian EEZ is cloud and haze 
free and/or turquoise plumes are visible in the Namibian EEZ), then :

• Right  click  on  each  picture  (quasi  true  colour,  chlorophyll  and SST)  and save  the 
pictures  under  a  directory  with  a  name  reflecting  the  date  of  the  image 
YYYY_MM_DD e.g. '2004_12_01.  Make sure there are no spaces in the directory 
name .

• Open the true colour picture (*.L1A_LAC_BRS) that you saved with an image viewer. 
If you can see turquoise plumes or hints  of them (you may have to zoom in),  you 
download the L2 image.  Order the image by clicking on Select this scene and placing 
an order.

OR to download the bzip2 compressed hdf file of the L2 image directly :  

• right click on the L2_LAC_OC hyperlink,

• copy link location,

• open Getright,

• File > enter new URL to download,

• OK, 

• indicate correct directory and click Save.
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B. Decompressing MODIS images
The MODIS images that are downloaded from NASA are in a compressed format ( *.gz or 
*.bz2).  After decompressing they are in hdf format (HDF4 format).

1. In Linux
Double click on the bz2 folder.

Click on Extract and indicate the directory you want to extract to (normally in the same folder 
as  the  bz2  folder  is  located,   a  directory  with  a  name  reflecting  the  date  of  the  image 
YYYY_MM_DD).

Click Extract.

Click  Close to  close  the  window  “Extracting  files  from  archive”  when  the  extraction  is 
completed successfully.

2. In Windows
A programme can be downloaded from the Internet to decompress bz2 files in Windows : go to 
the site  http://www.bzip.org/downloads.html and download the file bzip2-104-x86-win32.exe. 
Download  it  under  a  directory  that  is  easily  accessible  from  a  command  line  executable 
programme (high up in directory hierarchy and with a fairly short name, use no symbols like & 
because DOS seems not to recognise it when changing directory), for example something like : 
c:\My documents\bz2_decompress.

Save the bz2 file(s) you want to decompress in the same folder as the programme.  Let's assume 
this file is called NAMEOFFILE.bz2.

Start the command line executable programme (under accessories).  Change the directory to the 
directory where you saved the bz2 unzip programme with the cd (change directory) function, for 
example  :  cd bz2_decompress.   If  you want  to see the subdirectories  of the folder you are 
currently in, type : dir.

To see the help file of the programme, type : bzip2-104-x86-win32.exe - -help.  To decompress 
your files, type :  bzip2-104-x86-win32.exe -d NAMEOFFILE.bz2

Add the *.hdf file extension manually to the decompressed files (by typing them after the name 
in Explorer).
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C. Processing in SeaDAS
The main processing activity for the ocean colour mapping project is loading the hdf images in 
the  SeaDAS software,  projecting  the  image  and exporting  it  to  a  GeoTiff  format.   This  is 
because most image processing software can not work with the HDF format.

Make sure the hdf images are saved under the seadas_shared directory if you use seadasvm.

1. Start SeaDAS
Linux
Open Applications/System Tools/Terminal
Type ‘seadas -em’
The SeaDAS main menu will appear.

Seadasvm
double click on seadasvm icon

2. Displaying MODIS products
If you only want to export the image to geotiff format, without exploring it in Seadas, you will 
have to load and display it (see 2.1.1) and move on to section 3.

2.1 L2 products

Level 2 or L2 products refer to :

Modis 
Band

Own 
Reference

Name 
product

Explanation

8 Band 1 Rrs_412 Remote sensing reflectance at 412 nm (violet)
9 Band 2 Rrs_443 Same but  at  443 nm (violet-blue),  absorption  peak 

Chl a
3 Band 3 Rrs_469 blue
10 Band 4 Rrs_488 blue
11 Band 5 Rrs_531 green
12 Band 6 Rrs_547 green
4 Band 7 Rrs_555 green
1 Band 8 Rrs_645 red
13 Band 9 Rrs_667 red
14 Band 10 Rrs_678 red, close to 675 nm Chl a absorption peak)

chla chlor_a chlorophyll a concentration (in mg/m3) 
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• sea surface temperature : sst (in degrees Celsius)
• eps_78
• K_490
• angstrom_531
• tau_869
• 12_flags

2.1.1 Load and display L2 product
To load one or more of the L2 products, perform following actions :

• Click on Display
• Select  the  subdirectory  where  your  image  is  stored  (click  only once  for  selecting  a 

directory).
• Select the image you want to load (remember that you are loading an L2 product !)
• Click OK

The Product Selection for MODIS file window appears.  To display the image :

• Leave pixel and line sample rate on 1.
• Select the product(s) you want to display : for example chl_a or Select All
• Click Load

The Band List Selection Menu will appear.

• Select the band (product) you want to display and click Display.

The L2 product will be displayed in gray scale in a new window.  You can close this window by 
clicking on Quit.

2.1.2 Give color to L2 image
This step is only necessary if you want to have a closer look at the images in SeaDAS.  If your 
main aim is to export the image to a GIS compatible format, you can immediately move on to 
the next step.

• Select : Functions > Color LUT > Load LUT

If you are loading a predefined color table (LUT) :
• Select a color table of 1. IDL predefined color tables, e.g. Blue/Green/Red/Yellow
• Click Apply
• Click Quit
• Rescale for max Chl : Functions > Rescale
• type 40 as Max
• Click Redisplay and Quit

If you want to create your own LUT :
• Load a predefined LUT and make changes with :
• Options :  you can adjust the sliders  Stretch Bottom and  Stretch Top to change the 
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parameters
• Functions > Rescale : to rescale
• Save the color LUT by selecting : Functions > Color LUT > Save LUT
• Choose ASCII LUT file
• Save

If you are loading a LUT you created :
• Under 3. Load from ASCII or HDF file, click on Select
• Remove the *.hdf filter
• Browse to /home/vera/OC Research Results and select the color LUT file (make sure 

you scroll to bottom of files in directory)

2.1.3 Projecting images
An image has to be projected to the equatorial equidistant cylindrical projection if you want to 
export it in geotiff format with the new Seadas export tool. Currently, this is the only way that  
export to geotiff format can be done ; the image can not be projected to other projections (info  
from Seadas on-line assistance).

• Make sure the image you want to project is loaded
• Utilities > Data Manipulation > Map Projection
• Select a dataset to project by clicking on it in the selection list (you can select more than 

one band, they will all be projected with the same projection parameters)
• Missing value : -1
• Mapping option : individual 1

• Automatically load defaults : Yes
• Projections : Cylindrical
• Central latitude : 0, central longitude : 0
• Keep Unset Scale selected
• Indicate latitude and longitude limits (boundaries of study area)

• Walvis Bay : Lat Limit : -24, -22, Lon Limit : 10, 15
• Luderitz : Lat : -27.5, -25, Lon : 11, 16
• Namibia : lat : -30, -17, Lon : 8.5, 17

• Output size 2:
• for Walvis Bay : x = 515, y = 222
• for Luderitz : x = 515, y = 167
• for Namibia : x = 877, y = 1447

• Click Go.  
The mapped image will be added to the loaded bands.  This may take a while.

• Quit

If you only want to export the image, without exploring it, move on to section 3.

1 A composite would only stitch different swaths together
2 1 degree lat = 111,32 km ; 1 degr lon at -22 degr lat = 103,214 km

6



2.1.4 Exploring the L2 product
It is easier to explore the L2 product by making sure the roam and zoom windows are on by 
selecting : Functions > Roam Window On and Functions > Zoom Window On.

To find the coordinates of a certain pixel  (e.g.  Pixels of top left  and bottom right corners), 
select : Functions > Read and Profile.  This function can be used to define the pixels of certain 
longitudes and latitudes, i.e. those indicating the study area.

2.1.5 Creating true colour images
• Load an image as indicated in 2.1.1 : you should load at least 3 bands that will represent 

green, red and blue (you can load 1b bands, projected bands, l2 bands)
• Display each single band that you will use for the RGB and have a good look at its  

histogram :  Functions > Histogram.  This will allow you to determine an appropriate 
slope and intercept. Or rather with scatterplot : Utilities > Data Visualisation > Scatter 
Plot e.g. Max = 30000, S = 30000/255 = 118

• Go to : Utilities > Data Visualization > Load True color image
• Select Band List
• Select the band numbers (if all bands were loaded : 6 – 5 – 3 (or 4) for nLw_667 (R), 

nLw_551 (G) and nLw_488 (B)
• Enter the slopes and intercepts for each band (you will have to try a few combinations 

before obtaining a good composite)
• Click Load
• Select the true colour image in the Band List Selection Window (will be last band added 

to the list)
• Click Display

or  :  info  of  OC  website  http://oceancolor.gsfc.nasa.gov/forum/oceancolor/topic_show.pl?
tid=1863 : Using the User Defined Operations function, create a new empty band 

2.1.6 Layout
Before saving a picture of an L2 product, make sure following elements are indicated :

• Color Bar :  Functions > Color Bar > On (not necessary if you save picture as it is a 
separate option, see 2.1.7)

• Grid :
• Change the color of the grid to black with :  Setups > Grid (change value for 

latitude grid to 1, no labels), Go, close window
• Functions > Grid
• Setups > Landmark, Go

• Coastline : 
• Change the color of the coastline to white with : Setups > Coastline
• Go
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2.1.7 Saving as a picture
Save the L2 products as a picture with Functions > Output > Display.

• Change type to : Image Display
• Indicate Color Bar On
• Choose as color bar background light
• If necessary :  Indicate the area of which you want to save a picture (start/end column 

and row).
• Chose as file type *.png so it can be inserted in a document at a later stage.

The files are automatically saved to the home directory /home/vera and have to be moved to 
the /home/vera/OC Research Results directory afterwards.

2.1.8 Creating profile
Make sure the projected image is loaded and displayed

• Functions > Read and Profile
• Change Lat to line of profile e.g. Lat -23 and lon 14.3 for WB
• Click on move to lat/lon
• Click on profile plot set up : Data source : Geophysical,  Interactive mode : on, Log 

scaling : no, set Min to 0 and test Max, Quit
• Click on Plot Row Profile
• Click on Output
• Save as Postcript, Colour
• Manually add extension *.eps

To save : plot row profile

2.1.9 Display flags
As data is processed by msl12 from Level 1 to Level 2, checks are made for different defined 
conditions. When certain tests and conditions are met for a given pixel, a flag is applied to that 
pixel for that condition. The msl12 Level 2 processing flags are stored in the Level 2 data file 
as the "l2_flags" product (Mike, Ocean Color Forum, 2006).

Make sure both the 12_flags bands are loaded and the L1 or L2 image on which you want to 
apply them is displayed.

• Utilities > Data Visualization > Level 2 Flags Display
• Band number of loaded flag array : slide to number of band that contains the 12 

flags (this is normally done automatically)
• Display window for flag to be applied : slide to number of window that contains 

band on which you want to display flags
• Make sure that the flag type is l2gen L2 Flags  
• Indicate the flags you want to visualise.  If you want to see one flag, check it and 
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click Load One Mask (it will be automatically set to the last flag you checked). 
Otherwise, click on Load Multiple Masks.

2.1.10 Make a bit map of a flag
This is useful if you want to project one of the flags, e.g. the coccolithophore flag.  In that case, 
you first create a new band that is a bitmask of the flag.

• Make sure the l2 flags are loaded
• Select  Utilities > Data Manipulation > User-Defined Operation.
• Type in the band command window :

maskvalue = b1 and 1024
bitmap = maskvalue/maskvalue
result = bitmap

b1 refers to the band of the loaded l2 flags.  If the flags are in another band, you should change 
this to the number of that band.  The reason to mask the value 1024, is that it is the bit value (in 
decimal) for the COCCOLITH flag.  The l2 flags are a 32-bit array. The second line sets a value 
of 1 where the flag is set, 0 where it is not (Sean, Ocean Color Forum, 2010).

• Give a name to the new band, e.g. cocco_mask.
• be sure to set the navigation for this new band using the loaded l2_flags.
• You can save these settings by typing a name for the file to save (top of window) and 

clicking on Save.  Later, you can load this file after you type its name.
• Click Go to run the operation.

You can project the resulting bitmap and save it as a geotiff.

2.2 L1 products

L1 products are uncalibrated raw radiances referred to as ev_412, ev_443, ev_488,  ev_531, ...

L1A

L1B
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3. Exporting MODIS products
This section describes the export of L2 images to different formats.  

Always make sure the image is already displayed before exporting it.

Save mapped image as a Geotiff file :
• Functions > Output > Data > Binary
• In the Output Setup window near the top, for "Type:", select "Image Display" 
• In the Output Setup window near the bottom, for "File Type:", select "TIFF/GEOTIFF" 
• Click "Go" to save a new GeoTIFF file.

Save mapped image as an image :
• Functions > Output > Display
• Image data – Geophys
• Hdf sd

Save mapped image as an ascii file :
• Functions > Output > Data > Ascii
• (in Setup : Geophys data)
• Write file

The saved files are written to the home directory.
When loading/displaying such and image : rescale + log.
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D. Processing in ILWIS
Underneath  steps  are  described  for  ILWIS  3.6.   Note  that  you  can  choose  another  image 
processing package to create colour composites.  In this case, ILWIS is also used to digitise the 
plumes because the colour composite can not be exported to another format 3.  The end product 
of this processing phase will be one vector file (line format) with digitised plumes per image.

1. Creating colour composite
Import bands 4, 5 and 10 into ILWIS (give them the names B4, B5 and B10) as follows :

• File > Import > Geospatial Abstraction Data Library > raster > GeoTIFF
• Indicate the file you want to import and accept the proposed output file name
• Check Use as
• Click OK.

The images are imported as foreign collections.  Click on one of the raster images (the same 
raster image is shown in three fold) to view it.

Create a map list for the colour composite with File > Create > Map List.  Give the map list the 
name 4_5_10.  Select one time band 4, one time band 5 and one time band 10 and make sure 
they appear on the right list after you click on the > arrow.  Click OK.

To view the colour composite of bands 4, 5 and 10, double click on the map list.  Click on the 
left icon (Open as ColorComposite).  Click OK. 

2. Digitising plumes
If there are turquoise plumes, you will digitise them in a segment map.  Make sure you are in the 
view with the colour composite.  

• File > Create > Segment Map
• Indicate as map name : bloom_yyyy_mm_dd with yyyy the year the image was taken, 

mm the month and dd the day
• Indicate the same min/max latitude and longitude as when you were projecting the image 

: latitude 30º S - 17º S and longitude 8º30' E  - 17º E .  Note that ILWIS does not use the 
minus sign to indicate southern latitudes.

• Zoom in to the bloom you want to digitise.  Click on the icon for Insert Mode (or go to 
Edit > Insert Mode).

• Digitse the plume by clicking on its edges, double click to end digitising (this should be 
at your start point to close the polygon).

• The attribute table for this polygon will pop up.  As 'Name' you give an indication of the 
clearness of the plume, e.g. you type clear or vague.

• Click on the Exit Editor icon.

3 Error message : range too large for ERDAS format.
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• Close the view with the colour composite.

3. Export ILWIS segment map
To export the digitised plumes to a shape file :

• right click on the segment map that contains the digitised plumes and click Export.
• The format is Arc/View shapefile.  Click OK.

The file is now saved as a shapefile in the same directory.

D. Final processing in ArcView

Underneath steps are described for ArcView 3.1 with the EditTools 3.6 extension.  You can use 
a GIS software of your choice to do the same steps.  The end product is one clean, projected 
polygon file with the plumes per MODIS image.

Convert imported line files to polygons

To convert the imported segment maps of ILWIS to polygon files :

• open ArcView and add the shape file(s) with the plumes
• make sure the EditTools extension is loaded
• click on the ET icon
• click Edit Theme and indicate the shape file (ignore the message about the fact that your 

data is not projected)
• click Build Polygons.
• Accept the directory and name for the Temporary Polyline Theme.
• Click Yes to clean the polyline.
• Indicate the directory that contains the MODIS image for that shape file and give as file 

name the same name with a p behind, e.g. bloom_2003_04_03p.shp is saved under the 
directory 2003_04_03.

• Click No.

In ArcView, for calculation area, project to 'New' Transverse Mercator (central meridian 17, ref 
latitude 0).
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